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Introduction 
LecShare is a program that can convert PowerPoint presentation files (.ppt) into accessible HTML files 
and Microsoft Word documents.  Native PowerPoint (.ppt) files are not accessible to individuals with 
disabilities.  LecShare does the conversion, and with LecShare, it is not necessary to know the standards 
for web accessibility.  The workflow consists of checking a handful of elements in the PowerPoint file; the 
rest of the work is done by LecShare.  The result is an accessible HTML file.   

Humboldt State University has purchased a site license for LecShare, and it is available for all faculty, 
staff, and students.  LecShare Pro is available for an additional cost of $20 per license for those 
interested in creating accessible PowerPoint presentations that have an audio component.  LecShare 
Pro has the ability to add audio to Microsoft PowerPoint presentations to create QuickTime movies and 
MPEG-4 Video files (video podcasts). 

PowerPoint Presentations:  Live vs. Online 
Creating accessible “Live” PowerPoint presentations (presentations delivered to an audience) is different 
than creating accessible “Online” PowerPoint presentations (presentations accessed online or distributed 
via email).  There are processes and techniques that can be used to increase the accessibility of a “live” 
presentation, and these techniques will enhance the accessibility and usability of online presentations as 
well.  For example, using high-contrasting colors, using a sans-serif font greater than 20 point, avoiding 
animations and flashing objects, and limiting the amount of information on each slide will increase the 
accessibility of live PowerPoint presentations.  The slides will be easy to read and will not be cluttered 
with information nor distracting with animations and flashing objects.   

In addition to the design techniques suggested above, the audience will find the presentation more 
accessible if you read the contents of each slide.  Doing so will benefit the entire audience.  For example, 
the individual who forgot their glasses will not have to strain to read the slides, individuals are receiving 
the information in multiple modes, and those that cannot see the screen will be able to hear what others 
are seeing.  The process of reading each slide does not have to be as robotic as, “Now I will read the 
slide that is on the screen.  The first bullet says…”, etc.  It can be graceful, and the audience does not 
necessarily need to know that you are doing it.        

However, the techniques described above are not enough to overcome the accessibility issues with 
posting to the Internet or emailing the native PowerPoint (.ppt) file.  For an online PowerPoint 
presentation to be considered truly accessible, an accessible HTML version must also be provided. 
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Why is Conversion to HTML Necessary? 
There are several reasons, both accessible and non-accessible, why it is necessary to convert a 
Microsoft PowerPoint presentation into accessible HTML.  First, conversion is necessary because native 
PowerPoint (.ppt) files are not accessible to individuals who rely on assistive technologies, specifically, 
screen reading technology.  The PowerPoint Viewer Plug-in (which is necessary to view PowerPoint files 
online), is not accessible to those using screen reading software, and though some screen readers are 
able to read PowerPoint slides within Microsoft PowerPoint to a certain extent, it is not reliable enough to 
consider the reading experience truly accessible. 

 

Conversion is also necessary because individuals may not have the software required to view the 
PowerPoint presentation.  Either the PowerPoint Viewer Plug-in or the full version of Microsoft 
PowerPoint must be installed to view PowerPoint (.ppt) files.  Without this software, the individual will not 
be able to access the file.   

LecShare User Interface 

 
Figure 1 

Figure 1 above is a screen shot of the LecShare program interface with the main areas numbered and 
highlighted.  Following is a description of the seven main areas of the LecShare program interface: 

• #1 - Menu Bar:  The Menu Bar is similar to menu bars found in all programs.   

• #2 - Slide Preview:  The Slide Preview displays the full-view of the selected slide.   

• #3 - Object List:  The Object List area lists all elements of the selected slide and indicates whether 
each element meets accessibility standards.    

• #4 - Slide Tray:  The Slide Tray shows each slide in the presentation.  The slider bar at the bottom of 
the Slide Tray provides a quick way to scroll through all slides.  Clicking or selecting a slide in the 
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Slide Tray will update the Slide Preview and Object List areas with the contents of the slide that is 
selected. 

• #5 - Alternate Text Bar:  The Alternate Text Bar is a quick way to determine if all non-text elements 
have alternate text.  LecShare checks to see whether alternate text for non-text elements is present, 
and the Alternate Text Bar may indicate:  “Alternate Text OK” or “Alternate Text Missing”.   

• #6 - Title Bar:  The Title Bar is a quick way to determine if all slides have titles, specifically, non-
duplicating titles.  LecShare checks the slide titles, and the Title Bar may indicate:  “Title OK”, 
“Duplicate Title”, or “Missing Title”.  Selecting the Title Bar will bring up the Slide Titles list.  Slide 
titles can be added or changed in the Slide Title list. 

• #7 - Status Lights:  The Status Lights indicate whether there are accessibility issues with any slide 
elements.  A red light indicates there is an issue that must be corrected to ensure the HTML will meet 
accessibility guidelines.  A yellow light indicates there is an issue that may need to be addressed to 
ensure the HTML will meet accessibility guidelines.  

Converting to HTML Using LecShare 
The basic steps for converting a PowerPoint presentation into accessible HTML are below.  Following 
the basic steps are detailed instructions for completing each step. 

• Step 1 – Open LecShare 

• Step 2 – Open the PowerPoint presentation 

• Step 3 – Check the accessibility of the PowerPoint slide elements 

• Step 4 – Save the LecShare work 

• Step 5 – Export to HTML and perhaps to a Microsoft Word document 

Step 1 : Open LecShare 
1. Open LecShare like any other Macintosh program 

• A dialog box will appear requesting that all work in Microsoft PowerPoint, Excel, and Word be 
closed (Figure 2) 
 

 Figure 2 

Step 2 : Open PowerPoint Presentation 
After LecShare finishes loading, the next step is to open the PowerPoint presentation.  To open the 
PowerPoint presentation: 

1. File > Open 

2. The “Select a PowerPoint File to Process” dialog box opens (Figure 3) 

3. Navigate to the desired PowerPoint (.ppt) file 
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4. Select “Open” 

5. Be patient.  The process of loading the PowerPoint file can take some time depending on the size of 
the .ppt file   

 Figure 3 

Step 3 : Check Accessibility of PowerPoint Slide Elements 
There are several types of elements that must be checked before LecShare is able to make the 
conversion into an accessible HTML document.   

• All non-text elements must have alternate text 

• “Alt tag” for relevant or essential non-text elements  

• “Null string” for decorative or non-essential non-text elements 

• Tables, graphs, and charts must have essential elements identified 

• Tables must have titles, headers identified, and descriptions 

• Graphs and charts must have titles and descriptions  

• All slides must have unique titles 

• The order of slide elements must be checked on each slide to ensure the reading order is logical 

Alternate Text 
Images and other non-text elements must be formatted with alternate text descriptions because any 
object in the PowerPoint presentation that provides visual information cannot be understood by those 
that cannot view it.  Screen reading software will detect the image or object and will read the alternate 
text description if it has been provided. 

The text description should convey the same information to the user that the non-text element conveys; 
they are alternative representations of visual information provided in a text format.  The description 
should be short and to the point, while conveying equivalent information.  It is not necessary to include 
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the words, “Image of…” in your text description.  The assistive technology software will convey that 
information to the user, and it would be redundant to have that information in the text description as well. 

A good test to determine if a text equivalent is useful is to imagine reading the document aloud over the 
telephone.  What would you say upon encountering this image to make the page comprehensible to the 
listener? 

LecShare determines whether alternate text is present; it cannot evaluate whether the alternate text is 
equivalent to the meaning of the non-text element.  LecShare (or PowerPoint) may insert the filename 
as the alternate text for a non-text element, and the filename as alternate text is not an equivalent 
description of the non-text element.  It is good practice to check the alternate text for all non-text 
elements regardless if LecShare indicates the “Alternate Text is Missing” or the “Alternate Text 
OK”.  

Alternative Text for Essential Non-Text Elements (“Alt tag”) 
In HTML documents, the alternate text description provided depends on the purpose of the non-text 
element.  Again, the text description should convey the same information to the user that the image or 
picture conveys.  If the purpose of the non-text element is to convey information (i.e., it is an essential 
non-text element), the alternate text should convey equivalent information.  In LecShare, the alternate 
text description is inserted and “alt tag” is selected. 

Alternative Text for Non-Essential or Decorative Non-Text Elements (“Null String”) 
If the non-text element does not convey essential information (i.e., the non-text element is purely 
decorative and non-essential), the alternative text should be an “empty alt tag” or “null string”.  The 
alternate text is not actually empty; the HTML code is: alt= “ “. “Empty” or “null string” alternative text 
for non-essential or decorative non-text elements satisfies web accessibility standards because 
alternative text is present, albeit, “empty”.  Individuals using screen reading software are not distracted 
by the alternative text for non-essential, purely decorative non-text elements.   

Figure 4 
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Reviewing, Adding, and Editing Alternate Text for Non-Text Elements: 
1. Select the Alternate Text bar on the first slide that has a non-text element (Figure 4, #1).  The Slide 

Preview changes to reflect the chosen slide (Figure 4, #2) 

2. Select the area in the “Accessibility (Click to Edit)” box next to the non-text element in the Object List 
(Figure 4, #3) 

3. Review the text entered in the “Alternate Text” area of the Image Preview dialog box 

• If the non-text element is essential: 
1. Add or edit the Alternative Text in the space provided (Figure 5, #1) 
2. Select “Alt Tag” (Figure 5, #2) 
3. Select “Done” 

• If the non-text element is non-essential or decorative: 
1. Ensure the space provided for Alternative Text is blank (Figure 6, #1) 
2. Select “Decorative Image (null string)” (Figure 6, #2) 
3. Select “Done” 

4. Ignore the “Auto Select” and “Long Description” options in the Image Preview dialog box.  Long 
Descriptions are not widely supported by HTML browsers 

5. Repeat for all non-text elements in the PowerPoint presentation 

 Figure 5 
 

 Figure 6 
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Tables, Graphs, and Charts  

Tables 
Tables require the designation of certain elements to be considered accessible.  Again, LecShare takes 
care of creating the HTML code, but does require specific information to produce the accessible code for 
tables.  A Table Title, a Table Description, and the number and types of headers (column and/or row) 
must be identified to enable LecShare to create accessible HTML. 

Adding Required Table Information in LecShare: 
1. Select the slide in the Slide Tray 

2. Select the area in the “Accessibility (Click to Edit)” box next to the table in the Object List  
(Figure 7).  LecShare opens the Table Preview Dialog box (Figure 8) 

3. Add or Edit the Table Title (Figure 8, #1) 

4. Indicate the type and number of column and/or row headers (Figure 8, #2) 

5. Add or Edit a Table Description in the space provided (Figure 8, #3) 

6. Select “Done” 

 Figure 7 
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 Figure 8 

Graphs and Charts 
When working with graphs and charts, LecShare automatically assigns the title of the graph as the 
alternate text for the image of the graph.  LecShare indicates the “Alternate Text OK” (Figures 9 and 11) 
and does not give the option to edit this text.  Therefore, it is very important that graphs have titles. 

The title of the graph will not be adequate (a text equivalent) for the alternate text of the graph.  A good 
practice is to further describe the graph in the notes section of the original PowerPoint presentation and 
select “Include Lecture Notes” when exporting to accessible HTML from LecShare (see section on 
Exporting).  

Figure 9 below shows the LecShare program interface that appears upon encountering a graph or chart. 
Follow the steps below if LecShare is indicating that a graph or chart has “Missing Title/Description”: 

1. Select the slide in the Slide Tray 

2. Select the area in the “Accessibility (Click to Edit)” box next to the graph or chart in the Object List 
(Figure 9).  LecShare opens the Chart Preview dialog box (Figure 10) 

3. Enter the Chart Title for the graph or chart in the space provided (Figure 10, #1) 

4. Enter the Chart Description for the graph or chart in the space provided (Figure 10, #2) 

5. Select “Done” 
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  Figure 9 
 

 Figure 10 

 

Again, If the graph or chart has a title in the PowerPoint presentation, LecShare automatically assigns 
the alternate text as the title of the graph, and LecShare indicates the “Alternate Text OK” (Figure 11). 
Selecting the “Accessibility (Click to Edit)” box in the Object List next to the graph opens the Text 
Preview dialog box (Figure 12).  Again, the text in this box cannot be edited.
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 Figure 11 

 Figure 12 

Slide Titles 
In LecShare, slide titles serve two purposes.  First, the title of the PowerPoint slide is used as the title of 
the web page.  Web pages require a title for each page, and the title usually appears at the top of the 
web browser window. 

The second purpose of slide titles is for navigation within the Table of Contents which aids in the 
navigation of the HTML file.  It is important that each slide has a title and that slide titles are unique.  
Duplicate slide titles make navigation difficult. 

LecShare may indicate that slide titles are missing though they are present on the PowerPoint slide.  
PowerPoint has a special type of text box that it uses for official slide titles.  These text boxes can be 
easily erased and replaced with other text boxes that are not officially recognized as slide titles.  If this 
has happened, simply add a title for the slide in LecShare.  LecShare adds a hidden title, and the original 
PowerPoint file is not affected. 

Adding or Changing Slide Titles in LecShare: 
1. Select the slide in the Slide Tray 

2. Select the Title Bar beneath the slide.  LecShare opens the “Slide Titles” dialog box (Figure 13) 

3. Select the row of the slide that requires that a title be added or edited (Figure 14) 

 



11  

4. In the “Title” column, add or edit the title text 

5. Select “Done” 

 Figure 13 
 

 Figure 14 

Order of Slide Elements 
The reading order of slide elements is important for accurate comprehension of the slide.  Elements on a 
PowerPoint slide have an intrinsic reading order.  The order is defined by the order the items were 
created on the slide, not necessarily from left-to-right and top-to-bottom.    If the reading order is not 
accurate or in a logical order, individuals who rely on screen reading software for access will not be able 
to understand the slide.  LecShare allows the order to be modified so screen reading software will read 
the contents of the slide in the correct order.  Any changes made to the order of slide elements do not 
affect the way the slide looks or behaves (including transitions attached to elements) in PowerPoint. 

Re-Ordering Slide Elements in LecShare: 
1. Select the slide in the Slide Tray 

2. Select the element that requires re-ordering in the Object List (Figure 15, #1) 

3. Select “Up” or “Down” button to move the element (Figure 15, #2) 
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 Figure 15 

Step 4 : Save LecShare Work 
All work done in LecShare is saved back into the original PowerPoint file.  The changes are saved in a 
way that does not impact the editing or viewing of your presentation from within Microsoft PowerPoint.  
Any transitions, animations, etc. will be preserved and unaffected.  Saving changes made in LecShare is 
important because it saves time if the PowerPoint presentation requires reprocessing. To save the work 
done in LecShare: 

1. File > Save 

Step 5 : Export 
Exporting is the final step in LecShare.  Exporting creates an accessible HTML file; a Table of Contents 
and the Lecture Notes can be added to the HTML file if desired.  In addition to creating an HTML file, the 
PowerPoint presentation can be exported to a .zip Archive that can be emailed to students.  

LecShare has the option of exporting to a Microsoft Word document.  The resulting Word document is 
not accessible.  The Word document contains pictures of the slides in sequential order, and the file is 
not meant to meet accessibility standards.   

If the Word document is not accessible, why would it be used?  The Word document can be created and 
distributed to students who use a laptop to take notes during the presentation.  Students who use screen 
readers will not benefit from this, but other students may find it helpful to use the Word document to take 
notes on a laptop during the presentation.  Providing the Word document is similar to providing 
“Handouts” printed from within Microsoft PowerPoint.  The Word document exported from LecShare 
enables students to take digital notes whereas “Handouts” printed from Microsoft PowerPoint enable 
students to take paper notes. 
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Export to HTML, Microsoft Word, and .zip Archive 
1. File > Export.  LecShare opens the “Export Options” dialog box (Figure 16) 

2. Enter the “Title of Presentation” in the space provided 

• This title will appear at the top of each page 

• This is not the same as the file name or the title of each page 

3. Enter the optional Meta Tag Information, if desired 

4. Select “Include Table of Contents” if desired (highly recommended) 

5. Select “Include Lecturer’s Notes” if desired (highly recommended) 

6. Select “Create .zip Archive” if the HTML files will be e-mailed to students 

7. Select “Create Microsoft Word Document (Slides Only)” if desired 

8. Select “Export” 

9. When prompted, indicate where the files are to be saved.  Create a separate folder for the exported 
files 

10. Continue through other dialog boxes as appropriate until exporting is complete.  A dialog box will 
indicate when the exporting process is complete (Figure 17) 

 Figure 16 

 

 Figure 17 
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Linking, Uploading, and emailing HTML 
During the export process, LecShare creates several folders and files.  All are necessary for the correct 
rendering of the accessible HTML document.  Figure 18 shows the folders and files created in the export 
process.   

 Figure 18 

Uploading and Linking 
1. Upload the entire folder that was created during the export process 

2. Link to the “index.htm” page 

Emailing 
1. Email the .zip file.  All folders and files are contained within the .zip file   

2. When students “unzip” the file, all files will be unpacked to their appropriate folders 

3. Students will start the presentation by opening the “index.htm” page 
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Frequently Asked Questions 

How will the changes I make within LecShare affect my PowerPoint presentation? 
LecShare saves the changes you make in your original PowerPoint presentation.  The changes are 
saved in a way that does not impact the editing or viewing of your presentation from within Microsoft 
PowerPoint.  Any transitions, animations, etc. will be preserved and unaffected. 

What slide elements does LecShare convert? 
LecShare is able to convert the following elements into accessible HTML: 

• Text Boxes 

• WordArt 

• Images 

• AutoShapes 

• Tables 

• Charts and Graphs created in Microsoft Excel 

• Charts and Graphs created in Microsoft Graph (built-in chart/graph maker in PowerPoint) 

What slide elements is LecShare not able to convert? 
While LecShare will convert most elements of a PowerPoint file into accessible HTML, there are dynamic 
elements that can be used in PowerPoint files that LecShare cannot convert.  The following dynamic 
elements cannot be converted by LecShare, and will not be available in the accessible HTML version:     

• Audio 

• Video 

• Transitions 

• Animations 

Can I post the original PowerPoint (.ppt) file in addition to the accessible HTML 
version? 
Yes.  It is recommended that both versions of the PowerPoint file be posted online (the original .ppt file 
as well as the accessible HTML version).  If both versions are available, the native .ppt file will be 
available for those that prefer the slide show view of the PowerPoint presentation, and the accessible 
HTML version will be available for those that require it for accessibility reasons or for those that do not 
have the requisite software (PowerPoint or the PowerPoint Viewer Plug-in) installed on their computers.  
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nt 

• ion of the PowerPoint slide, and include the Lecture 

PowerPoint Best Practices 
• Save PowerPoint presentations as Office 2004 (.ppt) files.  LecShare cannot open Office 2008 (.pptx) 

files. 

• Do not save as a webpage from within Microsoft PowerPoint using either “Save As…[file type HTML], 
or “Save as Web Page…”.  The resulting HTML is not accessible. 

• Use sufficient color contrast between background and text colors. 

• Avoid using flashing images. 

• Avoid using animations. 

• Create charts and graphs using PowerPoint’s Chart Wizard. 

• Create tables using PowerPoint’s Insert > Table.  Do not use the Draw Table tool.  

• Ensure every slide has a title. 

• Minimize the use of Text Boxes using Insert > Text Box. 

• Add alternate text to non-text elements in PowerPoint before processing with LecShare.   

• Group images that have multiple parts.  Grouping will result in one image (with multiple parts), thus 
requiring only one alternate text description.  

• Use a PowerPoint template rather than a custom template and enter content only in the pre-defined 
areas. 

• If changes are required in the original PowerPoint file, the following steps are necessary:   

1. Exit LecShare  
2. Open PowerPoi
3. Make changes and save 
4. Exit PowerPoint 
5. Open LecShare 
6. Open PowerPoint file from within LecShare 

Describe all graphs and charts in the notes sect
Notes when exporting to HTML. 
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